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Install SnapCenter Plug-in for Microsoft
Windows

Installation workflow of SnapCenter Plug-in for Microsoft
Windows

You must install and set up SnapCenter Plug-in for Microsoft Windows if you want to
protect Windows files that are not database files.

| Log in to the Snaplenter Server using a web browser, |

v

| Iduntify storage types supportad. |

v

Set up credentials.

+

Review the Installation prereguisite:s and
install the plug-in package for Windows,

v

Ceonfigure and enable CA Certificate.

Installation requirements for SnapCenter Plug-in for
Microsoft Windows

You should be aware of certain installation requirements before you install the Plug-in for
Windows.

Before you begin to use the Plug-in for Windows, the SnapCenter administrator must install and configure
SnapCenter Server and perform prerequisite tasks.

* You must have SnapCenter admin privileges to install the Plug-in for Windows.
The SnapCenter admin role must have admin privileges.

* You must have installed and configured the SnapCenter Server.

* When installing a plug-in on a Windows host, if you specify a credential that is not built-in or if the user
belongs to a local workgroup user, you must disable UAC on the host.

* You must set up SnapMirror and SnapVault if you want backup replication.

Host requirements to install SnapCenter Plug-ins Package for Windows

Before you install the SnapCenter Plug-ins Package for Windows, you should be familiar with some basic host
system space requirements and sizing requirements.



Item Requirements

Operating Systems Microsoft Windows

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

If you are on a Windows cluster setup, you should
also install and configure the Windows Remote
Management (WinRM).

Minimum RAM for the SnapCenter plug-in on host 1GB

Minimum install and log space for the SnapCenter 5GB
plug-in on host

You should allocate sufficient disk
space and monitor the storage
consumption by the logs folder. The log
space required varies depending on

@ the number of the entities to be
protected and the frequency of data
protection operations. If there is no
sufficient disk space, the logs will not
be created for the recently run
operations.

Required software packages » .NET Core beginning with version 8.0.5 and
including all subsequent .NET 8 patches

* PowerShell Core 7.4.2

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

For .NET specific troubleshooting information, see
SnapCenter upgrade or install fails for legacy systems
that do not have internet connectivity.

Set up your credentials for the Plug-in for Windows

SnapCenter uses credentials to authenticate users for SnapCenter operations. You should create credentials
for installing SnapCenter plug-ins, and additional credentials for performing data protection operations on
Windows file systems.

What you will need

* You must set up Windows credentials before installing plug-ins.

* You must set up the credentials with administrator privileges, including administrator rights, on the remote
host.

* If you set up credentials for individual resource groups, and the user does not have full admin privileges,
you must assign at least the resource group and backup privileges to the user.


https://imt.netapp.com/matrix/imt.jsp?components=121074;&solution=1257&isHWU&src=IMT
https://imt.netapp.com/matrix/imt.jsp?components=121074;&solution=1257&isHWU&src=IMT
https://kb.netapp.com/mgmt/SnapCenter/SnapCenter_upgrade_or_install_fails_with_This_KB_is_not_related_to_the_OS
https://kb.netapp.com/mgmt/SnapCenter/SnapCenter_upgrade_or_install_fails_with_This_KB_is_not_related_to_the_OS

Steps

1. In the left navigation pane, click Settings.

2. In the Settings page, click Credential.
3. Click New.
4. In the Credential page, do the following:

For this field...

Credential name

User name/Password

Password

5. Click OK.

Do this...

Enter a name for the credentials.

Enter the user name and password used for
authentication.

* Domain administrator or any member of the
administrator group

Specify the domain administrator or any
member of the administrator group on the
system on which you are installing the
SnapCenter plug-in. Valid formats for the
Username field are as follows:

° NetBIOS\UserName
° Domain FQDN\UserName
° UserName@upn

 Local administrator (for workgroups only)

For systems that belong to a workgroup, specify
the built-in local administrator on the system on
which you are installing the SnapCenter plug-in.
You can specify a local user account that
belongs to the local administrators group if the
user account has elevated privileges or the User
Access control feature is disabled on the host
system. The valid format for the Username field
is as follows: UserName

Do not use double quotes (") or backtick () in
the passwords. You should not use the less
than (<) and exclamation (!) symbols together in
passwords. For example, lessthan<!10,
lessthan10<!, backtick™12.

Enter the password used for authentication.

After you finish setting up credentials, you might want to assign credential maintenance to a user or group



of users on the User and Access page.

Configure gMSA on Windows Server 2016 or later

Windows Server 2016 or later enables you to create a group Managed Service Account (gMSA) that provides
automated service account password management from a managed domain account.

Before you begin
* You should have a Windows Server 2016 or later domain controller.

* You should have a Windows Server 2016 or later host, which is a member of the domain.

Steps
1. Create a KDS root key to generate unique passwords for each object in your gMSA.

2. For each domain, run the following command from the Windows domain controller: Add-KDSRootKey
-Effectivelmmediately

3. Create and configure your gMSA:

a. Create a user group account in the following format:
domainName\accountNames$

b. Add computer objects to the group.

c. Use the user group you just created to create the gMSA.

For example,

New-ADServiceAccount -name <ServiceAccountName> -DNSHostName <fgdn>
-PrincipalsAllowedToRetrieveManagedPassword <group>
-ServicePrincipalNames <SPN1, SPN2,.>

d. Run Get-ADServiceAccount command to verify the service account.
4. Configure the gMSA on your hosts:

a. Enable the Active Directory module for Windows PowerShell on the host where you want to use the
gMSA account.

To do this, run the following command from PowerShell:



PS C:\> Get-WindowsFeature AD-Domain-Services

Display Name Name Install
State

[ ] Active Directory Domain Services AD-Domain-Services Available

PS C:\> Install-WindowsFeature AD-DOMAIN-SERVICES

Success Restart Needed Exit Code Feature Result

True No Success {Active Directory Domain
Services, Active

WARNING: Windows automatic updating is not enabled. To ensure that
your newly-installed role or feature 1is

automatically updated, turn on Windows Update.

b. Restart your host.

c. Install the gMSA on your host by running the following command from the PowerShell command
prompt: Install-AdServiceAccount <gMSA>

d. Verify your gMSA account by running the following command: Test-AdServiceAccount <gMSA>
5. Assign the administrative privileges to the configured gMSA on the host.
6. Add the Windows host by specifying the configured gMSA account in the SnapCenter Server.

SnapCenter Server will install the selected plug-ins on the host and the specified gMSA will be used as the
service log on account during the plug-in installation.

Add hosts and install SnapCenter Plug-in for Microsoft
Windows

You can use the SnapCenter Add Host page to add Windows hosts. The SnapCenter
Plug-in for Microsoft Windows is automatically installed on the specified host. This is the
recommended method for installing plug-ins. You can add a host and install a plug-in
either for an individual host or a cluster.

Before you begin

« If the operating system of the SnapCenter Server host is Windows 2019 and the operating system of the
plug-in host is Windows 2022, you should perform the following:

> Upgrade to Windows Server 2019 (OS Build 17763.5936) or later
o Upgrade to Windows Server 2022 (OS Build 20348.2402) or later

* You must be a user that is assigned to a role that has the plug-in install and uninstall permissions, such as



the SnapCenter Admin role.

* When installing a plug-in on a Windows host, if you specify a credential that is not built-in or if the user
belongs to a local workgroup user, you must disable UAC on the host.

» The SnapCenter user should be added to the “Log on as a service” role of the Windows Server.
* You should ensure that the message queueing service is in running state.
* If you are using group Managed Service Account (gMSA), you should configure gMSA with administrative

privileges.

Configure group Managed Service Account on Windows Server 2016 or later for Windows File System

About this task
* You cannot add a SnapCenter Server as a plug-in host to another SnapCenter Server.

* Windows plug-ins
o Microsoft Windows
> Microsoft Exchange Server
> Microsoft SQL Server
o SAP HANA
* Installing plug-ins on a cluster

If you install plug-ins on a cluster (WSFC, Oracle RAC, or Exchange DAG), they are installed on all of the
nodes of the cluster.

+ E-series storage

You cannot install the Plug-in for Windows on a Windows host connected to E-series storage.

SnapCenter does not support adding of the same host (plug-in host) to SnapCenter if the host is
already part of a workgroup and changed to another domain or vice versa. If you want to add the
same host, you should remove the host from SnapCenter and add it again.

Steps
1. In the left navigation pane, click Hosts.

2. Ensure that Managed Hosts is selected at the top.
3. Click Add.
4. In the Hosts page, do the following:

For this field... Do this...
Host Type Select the Windows type of host.

SnapCenter Server adds the host and then installs
the Plug-in for Windows if it is not already installed
on the host.
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For this field... Do this...
Host name Enter the fully qualified domain name (FQDN) or the
IP address of the host.

SnapCenter depends on the proper configuration of
the DNS. Therefore, the best practice is to enter the
fully qualified domain name (FQDN).

You can enter the IP addresses or FQDN of one of
the following:
» Stand-alone host
» Windows Server Failover Clustering (WSFC)
If you are adding a host using SnapCenter and

it is part of a subdomain, you must provide the
FQDN.

Credentials Select the credential name that you created or
create the new credentials.

The credential must have administrative rights on
the remote host. For details, see information about
creating a credential.

Details about credentials, including the user name,

domain, and host type, are displayed by placing
your cursor over the credential name you provided.

The authentication mode is
determined by the host type that you
specify in the Add Host wizard.

5. In the Select Plug-ins to Install section, select the plug-ins to install.
For new deployments, no plug-in packages are listed.

6. (Optional) Click More Options.



For this field... Do this...

Port Either retain the default port number or specify the
port number.

The default port number is 8145. If the SnapCenter
Server was installed on a custom port, that port
number will be displayed as the default port.

If you manually installed the plug-ins
@ and specified a custom port, you

must specify the same port.

Otherwise, the operation fails.

Installation Path The default path is C:\Program
Files\NetApp\SnapCenter.

You can optionally customize the path. For
SnapCenter Plug-ins Package for Windows, the
default path is C:\Program
Files\NetApp\SnapCenter. However, if you want,
you can customize the default path.

Add all hosts in the cluster Select this check box to add all of the cluster nodes
in a WSFC.
Skip preinstall checks Select this check box if you already installed the

plug-ins manually and you do not want to validate
whether the host meets the requirements for
installing the plug-in.

Use group Managed Service Account (gMSA) to run Select this check box if you want to use group
the plug-in services Managed Service Account (gMSA) to run the plug-in
services.

Provide the gMSA name in the following format:
domainName\accountName$.

gMSA will be used as a log on
@ service account only for SnapCenter
Plug-in for Windows service.

7. Click Submit.

If you have not selected the Skip prechecks checkbox, the host is validated to see whether it meets the
requirements to install the plug-in. The disk space, RAM, PowerShell version, .NET version, and location
are validated against the minimum requirements. If the minimum requirements are not met, appropriate
error or warning messages are displayed.

If the error is related to disk space or RAM, you can update the web.config file located at C: \Program
Files\NetApp\SnapCenter WebApp to modify the default values. If the error is related to other



parameters, you must fix the issue.
(D In an HA setup, if you are updating web.config file, you must update the file on both nodes.

8. Monitor the installation progress.

Install SnapCenter Plug-in for Microsoft Windows on
multiple remote hosts using PowerShell cmdlets

If you want to install SnapCenter Plug-in for Microsoft Windows on multiple hosts at one
time, you can do so by using the Install-SmHostPackage PowerShell cmdlet.

You must have logged in to SnapCenter as a domain user with local administrator rights on each host on which
you want to install plug-ins.

Steps
1. Launch PowerShell.

2. On the SnapCenter Server host, establish a session using the Open-SmConnection cmdlet, and then
enter your credentials.

3. Add the standalone host or the cluster to SnapCenter using the Add-SmHost cmdlet and the required
parameters.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter
Software Cmdlet Reference Guide.

4. Install the plug-in on multiple hosts using the Install-SmHostPackage cmdlet and the required
parameters.

You can use the -skipprecheck option when you have installed the plug-ins manually and do not want to
validate whether the host meets the requirements to install the plug-in.

Install the SnapCenter Plug-in for Microsoft Windows
silently from the command line

You can install the SnapCenter Plug-in for Microsoft Windows locally on a Windows host
if you are unable to install the plug-in remotely from the SnapCenter GUI. You can run the
SnapCenter Plug-in for Microsoft Windows installation program unattended, in silent
mode, from the Windows command line.

Before you begin
* You must have installed Microsoft .Net 4.7.2 or later.

* You must have installed PowerShell 7.4.2 or later.
* You must have turned on Windows message queuing.

* You must be a local administrator on the host.

Steps
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1. Download the SnapCenter Plug-in for Microsoft Windows from your install location.
For example, the default installation path is C:\ProgramData\NetApp\SnapCenter\Package Repository.
This path is accessible from the host where the SnapCenter Server is installed.

2. Copy the installation file to the host on which you want to install the plug-in.

3. From the command prompt, navigate to the directory where you downloaded the installation file.

4. Enter the following command, replacing variables with your data:
"snapcenter windows host plugin.exe"/silent / debuglog"" /log""

BI_SNAPCENTER_PORT= SUITE_INSTALLDIR="" BI_SERVICEACCOUNT= BI_SERVICEPWD=
ISFeatureInstall=SCW

For example:
""C:\ProgramData\NetApp\SnapCenter\Package Repository
\snapcenter windows host plugin.exe"/silent /debuglog"C:
\HPPW_SCW_Install.log" /log"C:\" BI SNAPCENTER PORT=8145
SUITE INSTALLDIR="C: \Program Files\NetApp\SnapCenter"

BI SERVICEACCOUNT=domain\administrator BI SERVICEPWD=password
ISFeatureInstall=SCW"

(D All the parameters passed during the installation of Plug-in for Windows are case sensitive.

Enter the values for the following variables:

Variable Value

/debuglog”"<Debug Log Path> Specify the name and location of the suite installer
log file, as in the following example: Setup.exe
/debuglog"C:\PathToLog\setupexe.log".

Bl_SNAPCENTER_PORT Specify the port on which SnapCenter
communicates with SMCore.

SUITE_INSTALLDIR Specify host plug-in package installation directory.

BI_SERVICEACCOUNT Specify SnapCenter Plug-in for Microsoft Windows
web service account.

Bl_SERVICEPWD Specify the password for SnapCenter Plug-in for
Microsoft Windows web service account.

ISFeaturelnstall Specify the solution to be deployed by SnapCenter
on remote host.

The debuglog parameter includes the path of the log file for SnapCenter. Writing to this log file is the
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preferred method of obtaining troubleshooting information, because the file contains the results of checks
that the installation performs for plug-in prerequisites.

If necessary, you can find additional troubleshooting information in the log file for the SnapCenter for
Windows package. Log files for the package are listed (oldest first) in the % Temp% folder, for example,
C:\temp\.

The installation of Plug-in for Windows registers the plug-in on the host and not on the

@ SnapCenter Server. You can register the plug-in on the SnapCenter Server by adding the
host using the SnapCenter GUI or PowerShell cmdlet. After the host is added, the plug-in is
automatically discovered.

Monitor SnapCenter plug-in package installation status

You can monitor the progress of SnapCenter plug-in package installation by using the
Jobs page. You might want to check the progress of installation to determine when it is
complete or if there is an issue.

About this task
The following icons appear on the Jobs page and indicate the state of the operation:

In progress
. Completed successfully
 x Failed

Completed with warnings or could not start due to warnings

* 9 Queued

Steps
1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.
3. In the Jobs page, to filter the list so that only plug-in installation operations are listed, do the following:
a. Click Filter.
b. Optional: Specify the start and end date.
c. From the Type drop-down menu, select Plug-in installation.
d. From the Status drop-down menu, select the installation status.
e. Click Apply.
4. Select the installation job and click Details to view the job details.

5. In the Job Details page, click View logs.

Configure CA certificate
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Generate CA Certificate CSR file

You can generate a Certificate Signing Request (CSR) and import the certificate that can
be obtained from a Certificate Authority (CA) using the generated CSR. The certificate will
have a private key associated with it.

CSR is a block of encoded text that is given to an authorized certificate vendor to procure the signed CA
certificate.

(i)  CACertificate RSAkey length must be minimum 3072 bits.
For information to generate a CSR, see How to generate CA Certificate CSR file.

If you own the CA certificate for your domain (*.domain.company.com) or your system
(machine1.domain.company.com), you can skip generating the CA Certificate CSR file. You can
deploy the existing CA certificate with SnapCenter.

For cluster configurations, the cluster name (virtual cluster FQDN), and the respective host names should be
mentioned in the CA certificate. The certificate can be updated by filling the Subject Alternative Name (SAN)
field before procuring the certificate. For a wild card certificate (*.domain.company.com), the certificate will
contain all the hostnames of the domain implicitly.

Import CA certificates

You must import the CA certificates to the SnapCenter Server and the Windows host
plug-ins using the Microsoft management console (MMC).

Steps
1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.
3. In the Certificates snap-in window, select the Computer account option, and then click Finish.

4. Click Console Root > Certificates — Local Computer > Trusted Root Certification Authorities >
Certificates.

5. Right-click on the folder “Trusted Root Certification Authorities”, and then select All Tasks > Import to start
the import wizard.

6. Complete the wizard, as follows:

In this wizard window... Do the following...

Import Private Key Select the option Yes, import the private key, and
then click Next.

Import File Format Make no changes; click Next.

Security Specify the new password to be used for the
exported certificate, and then click Next.

12
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In this wizard window... Do the following...

Completing the Certificate Import Wizard Review the summary, and then click Finish to start
the import.

@ Importing certificate should be bundled with the private key (supported formats are: *.pfx,
*.p12, and *.p7b).

7. Repeat Step 5 for the “Personal” folder.

Get the CA certificate thumbprint

A certificate thumbprint is a hexadecimal string that identifies a certificate. A thumbprint is
calculated from the content of the certificate using a thumbprint algorithm.

Steps
1. Perform the following on the GUI:

Double-click the certificate.

a.
b. In the Certificate dialog box, click the Details tab.

o

Scroll through the list of fields and click Thumbprint.
d. Copy the hexadecimal characters from the box.

e. Remove the spaces between the hexadecimal numbers.

For example, if the thumbprint is: "a9 09 50 2d d8 2a e4 14 33 e6 f8 38 86 b0 0d 42 77 a3 2a 7b", after
removing the spaces, it will be: "a909502dd82ae41433e6f83886b00d4277a32a7b".

2. Perform the following from PowerShell:

a. Run the following command to list the thumbprint of the installed certificate and identify the recently
installed certificate by the subject name.

Get-Childltem -Path Cert:\LocalMachine\My

b. Copy the thumbprint.

Configure CA certificate with Windows host plug-in services

You should configure the CA certificate with Windows host plug-in services to activate the
installed digital certificate.

Perform the following steps on the SnapCenter Server and all the plug-in hosts where CA certificates are
already deployed.

Steps
1. Remove the existing certificate binding with SMCore default port 8145, by running the following command:

> netsh http delete sslcert ipport=0.0.0.0: <SMCore Port>

For example:
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> netsh http delete sslcert ipport=0.0.0.0:8145

2. Bind the newly installed certificate with the Windows host plug-in services, by running the following
commands:

> $cert = Y <certificate thumbprint> ”
> Sguid ("B")
> netsh http add sslcert ipport=0.0.0.0:
appid="$guid"

[guid] : :NewGuid () .ToString
_<SMCore Port> certhash=$cert

For example:

> Scert = “a909502dd82ae41433e6£83886b00d4277a32a7b”

> S$guid = [guid]::NewGuid () .ToString ("B")

> netsh http add sslcert ipport=0.0.0.0: <SMCore Port> certhash=Scert
appid="s$guid"

Enable CA Certificates for plug-ins

You should configure the CA certificates and deploy the CA certificates in the SnapCenter
Server and the corresponding plug-in hosts. You should enable the CA certificate
validation for the plug-ins.

Before you begin
* You can enable or disable the CA certificates using the run Set-SmCertificateSettings cmdlet.

* You can display the certificate status for the plug-ins using the Get-SmCertificateSettings.
The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps
1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Managed Hosts.
3. Select single or multiple plug-in hosts.

4. Click More options.

5. Select Enable Certificate Validation.

After you finish

The Managed Hosts tab host displays a padlock and the color of the padlock indicates the status of the
connection between SnapCenter Server and the plug-in host.

. indicates that the CA certificate is neither enabled nor assigned to the plug-in host.
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* (5 indicates that the CA certificate is successfully validated.
* | indicates that the CA certificate could not be validated.

* @ indicates that the connection information could not be retrieved.

@ When the status is yellow or green, the data protection operations completes successfully.
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